BERKS CO. TECHNOLOGY INSTRUCTIONS
1. Instructional Video
Uses of Digital Videos in Physical Education

1. Instruction: 

a. Create instructional videos shown in class (using weight room stations, water aerobics session, etc)

b. Record a student skill performance and immediately play it back (tennis serve, golf swing…)

c. Make-up for missed classes where students watch a lesson in the library on their own time and complete an assignment

2. Website:

a. Post videos of students in class (climbing the rock wall, learning pilates, etc)

b. Post interviews with teachers

c. Explain the purpose of PE and your program

3. Display:

a. Post pictures on bulletin boards

b. Incorporate pictures into handouts and flyers home

4. Advocacy:

a. Video during parent night 

b. Year end highlight review video

5. Other: 

a. Create a workout video

b. Reward or document off-task behavior??

Instructions for Editing a Video Using Windows Movie Maker 2.6
Download program from: 

Before You Begin: Students in the past have experienced problems when switching between multiple computers or storing files in different locations.  It is advisable to store files in the same location, one folder on a flash drive for example, and using the same computer. 

1. Start Movie Maker (automatically included in Windows XP and Vista computers) – Click the start icon and browse for Movie Maker under “All Programs.”  Usually, it is listed inside the “Accessories” folder but it may be elsewhere.  

If you don’t have Movie Maker installed on your computer (not pre-installed on Windows 7 computers), use this link: http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=34 
2. Click the tasks icon [image: image29.png]


on the taskbar at the top (if it is not already toggled).  

3. Click “import video,” select the video to import, then click “import”

4. Click “import audio or music” and follow the same steps as for the video.

a. You can import mp3, wav, and most audio files into Movie Maker

b. To see the video and audio you’ve imported, click the “collections” icon [image: image2.jpg]I Collections



 in the taskbar.  

5. Near the bottom of the screen, if you see the words “show timeline,” click them.  If you see the words, “show storyboard,” do not click them.  You want to be able to view the timeline.  Both views are useful but you will utilize timeline for most tasks.  

6. Adding files to the storyboard

a. Add video – Click the video or video segment (you can select multiple video segments) and drag it down to the storyboard.  

b. Add audio - To add audio to your movie, again click the file and drag it down to the storyboard.  If you’re having trouble locating the audio file, click the “collections” icon at the top, then drag the audio file (denoted by a musical note) [image: image3.jpg]


 down to the storyboard.  To move the audio file along the timeline, click the middle of the file and drag it left or right to the desired position. 

7. Editing your video

a. Preview - To preview a movie, use the standard controls [image: image4.jpg]


 below the display area on the far right side.  

a. If you’d like to start the preview from a certain place, click that place in the timeline first and then click play.

b. In the “movie tasks” 
[image: image5.png]Movie Tasks



panel, make sure the options under the #2 “edit movie” are displayed.  If they are not, click the downward arrow 
[image: image6.png]


 to display them.  You should see tasks such as “view video effects.”  

c. Title - Add a title by clicking “make title or credits.”   Follow the on-screen directions.  After you click “Done, add title to movie,” it will appear in the timeline.  

d. Effect - Add an effect to a title or video by clicking “view video effects.”  To add the effect, drag one down to the storyboard and ONTO a video or title.  

e. Transition - To add a video transition, click the “tasks” icon in the taskbar, click “view video transitions” and drag the desired video transition down BETWEEN two videos or titles.  You will not be allowed to add a transition if there is not a title/video on either side of the transition.

f. Trimming audio, video, or titles – If you’d like to trim from the beginning or end of the video, audio, or title, first click on the item in the timeline view.  Next, hover your cursor over the end of the item.  When a red double arrow appears 
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, click the end of the item and drag it either left or right.

g. Cutting video – If there is a segment in the middle of the audio or video file which you would like to remove, you’ll have to cut the video into segments and then trim in the manner describe above.  To cut a video, play it and pause it at the desired cut location.  Next click the cut tool [image: image8.jpg]


.

h. Picture - If you’d like to take a picture of a segment of video, pause the video during playback at the desire location, and click the photo tool [image: image9.jpg]


.  You’ll see your photo appear in the collections window.

i. Zoom - Sometimes, the timeline can be hard to view.  To expand the timeline, click the zoom icon [image: image10.jpg]


 to expand the timeline so it’s more manageable.  

j. Delete - If you want to delete and audio, video, or transition from the timeline or storyboard, right click your mouse on it and then select delete.

k. Simultaneous audio – Sometimes you may have two audio files with the same video file. For example, if you record a video with your digital camera (usually has audio embedded) and then add an mp3 file, you have two audio segments.  In these instances, click the audio levels icon 
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 and specify the level for each segment.  For example, if you move the indicator to the far right, you will only hear the audio/music file and not the audio embedded with the video.

l. Narrate – This is a great feature used when you want to record you voice or narrate into the video.  If your computer doesn’t come with a built-in microphone, plug one into the microphone jack designated by the symbol [image: image12.jpg]


.  When you are ready to record your narrative, click the narrate timeline button and begin. 
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8. Saving

a. Periodically during the creation of your video, save it.  Under the file menu click “save project.”  Be aware that the project you save IS NOT a movie and cannot be played outside of movie maker.  

b. To save your project as a movie file, click “File” in the menu bar then select “Save Movie File” for Windows XP computers and “Publish Movie” for Windows Vista computers.  Next, select “my computer,” give the file a name, and browse for the desired location.  You may adjust the size of the file but I suggest the “Best Quality for Playback.”  Afterwards, play the file in iTunes, Windows Media Player, Real Player, or any other program to verify successful creation. 

i. This may take several minutes depending on the movie’s length and your computer.

9. Trouble Shooting

a. Red X’s – If movie maker displays red X’s, it means that the program cannot find the files associated with your video.  To correct this, right click on the red X and select “browse for missing file.”  Under “files of type”, you may need to select “all files” for your to browse all available files.  

Cloud Video Editing Websites

1. YouTube Remixer

2. PhotoBucket

3. Kaltura

4. Editor One

5. MotionBox
2 – Interactive PowerPoints 

Targets
Setup

1. Decide upon a theme for your PowerPoint (space invaders, fast food furry, couch potato)

2. Save images (small size) that will serve as the targets, for my example a UFO, an alien, and some asteroids.  

3. Start a new PowerPoint presentation and from the “design” tab, select a theme.  If necessary, add a background color from the “background styles” pull-down menu. 

Adding and Modifying Targets

1. Click the “insert” tab, then “picture” and browse for the desired image.  

2. [image: image1.jpg]H



To make the image move, click “animations,” “add animation,” and then “more motion paths.”  Select any of the options listed
a. Once you have selected a path, a dotted line will appear signifying the direction of the animation.  You can customize the path by stretching it out or rotating it (click green circle).  

3. Click the “Animation Pane” icon in the ribbon.  To make all the animations start at the same time, from the pull down menu next to each animation, select “start with previous.”  To make the animations appear when you click the mouse, select “start on click,” that way they will appear one at a time.  

4. To add sounds, from the same pull-down menu as in step 3, select “effect options” and under “enhancements” select a sound and click OK.
5. To control the speed of the animation, from the same pull-down menu as in step 3, select “effect options” and then the “timing” tab at the top.  Select a speed with the duration pull-down menu.  

6. You can specify the number of times you would like an image to repeat its path or indefinitely until the next click by choosing among the pull down options next to “repeat” on the “timing tab” of “effect options”

7. Repeat the above steps to add more targets

8. If you would like multiple images to move simultaneously, from the “timing” tab, select “with previous.”  If you would like one image to finish before the other moves, select “after previous.”  You may add more slides or insert all of the animations onto one slide.  

9. To add music, on the “insert” tab of the ribbon, select “audio” (on far right) and follow the prompts.  

10. If you are using several slides, set the slides to automatically change from the “transitions” tab of the ribbon.  Specify a time below “advance slide.” You may also choose to designate a transition scheme if desired.  
To really excite the students, move the projector away from the wall so the PowerPoint covers a huge segment of it.  You may have to dim the lights slightly or select dark images to better differentiate the targets.  To extend the task, count the number of hits students get during the PowerPoint and try to beat their previous record.  If there is enough space, have students work individually and if not, have one be a spotter or collector while the other throws.  Play sci-fi or other music in addition to or in place of the sound effects.  

Jeopardy Questions

1. Slide 1 - Create a title page for the powerpoint 
2. Slide 2 – Create the “jeopardy” board with point values

a. On the “home” tab of the ribbon, click the “slide layout” pull down menu and select “two content” 

b. Create a title for the slide

c. Click the perimeter of the left box.  Click the lower right corner of the box and hold the click.  Move the mouse to resize the box so it is 5 times taller than it is wide.  

d. Right click on the perimeter of the box and select “format shape.”  Click “fill,” “solid fill” and then select a color under “fill color” then close.  You may use additional formatting tools as well (shadows, edges, 3D etc)
e. Click inside the box and on different lines insert a title for the box and point values, typically 100, 200, 300, 400 and 500.  

f. Right click on the box and select “copy.” Then on the “home” tab of the ribbon, click “Paste.”  An exact copy of the first text box will appear.  Click the perimeter, hold the click, and drag it next to the first text box.  Repeat this procedure three additional times to create a total of five columns.  Afterwards, you can adjust the color of each box so it is different using the procedures above. 

3. Slide 3 – 7
a. While still on slide 2, select the home tab from the ribbon, click “New Slide” and then select “Title and Content.”  Go to slide 3.

b. Slide 3 corresponds to column one of slide 2, question 100.  Title the slide with the column heading from slide 2 and the point value.  

c. Write your question in the larger box below

d. Towards the bottom of the larger box, write the title of slide 2 or any other text that signifies returning to the jeopardy board on slide 2.  Highlight this text and on the “insert” tab of the ribbon, click “hyperlink.”  In the new box that appears, click “place in this document” and then under slide titles, select the one corresponding to the jeopardy board (typically slide 2).  Click OK.  
e. Click the design tab on the ribbon and select either a “theme” or “background style.”  

f. Click the small image of slide three on the left.  On the home tab, click “new slide” and then “duplicate selected slides.”  Slide 4 will appear which will be an exact copy of slide three.  Repeat this step three more times so there are five identical slides.  Go to slide 4, change the point value to 200 and write a new question.  Continue for slides 5, 6 and 7.  

4. Slides 8 – X

a. Repeat step 3 for each of the four remaining columns.  A shortcut would be to use the format of slides 3-7 for the remainder of all slides.  
5. Formatting the jeopardy grid

a. Return to slide 2, highlight the 100 in the first column.  On the “insert” tab of the ribbon, click hyperlink.  Click “place in this document” and select slide 3.  Repeat this process for every point value.  

6. Check to see that all the links work
Option 3 - Website 
Sample Website: http://thenewPE.com 

Ideas for Website Topics

	· After school activities (PE Potpourri, Circus Arts, 

· Awards

· Benefits of physical activity

· Breakdown of PE focus in each grade

· Calendar of PE events throughout year

· Classroom learning expectations (rules)

· Community events (kids marathon, sand castle building contest, roller blading club)

· Contact info for teachers 

· Current Issues in Health and PE (PE vs physical activity, excemptions, etc)

· Donations

· Dress for PE

· Equipment Loan Program

· Equipment safety (helmets, bikes, etc)

· FAQ’s

· Field Trips

· Fitness: Getting Your Child Off the Coach

· Fitness Testing Info

· Grading scale

· Health and Wellness News (water bottles, Atkins, trans-fats, home exercises, etc)

· Homework assignments 

· Ideas for Getting Active

· Importance of PE (advocacy)

· Links in community to physical activity: recreation departments, marathons, state parks, swim lessons, etc. 

· Medical excuse policy

· Meet the Teachers

· Misc: Handwashing, Beating the Common Cold, Family Safety Plan


	· Newsletters

· Nutrition corner

· Parents Corner

· PE class schedule

· PE Quotes

· Pencil and Paper Games (crossword puzzle, word search)

· Philosophy/Overview of program

· Pictures

· Programs: Mileage club, Jump Rope for Heart

· Quotes from kids (“From the Mouth of Babes”) 

· Recipes (healthy)

· Recommendations from different agencies (CDC, NASPE, Agriculture Dept, Heart Assoc)

· Recreation Opportunities commercial – roller skating rink, kids playland)

· Safety tips: helmet safety, seat belts, allergies, choking

· Summarize a PE journal article or NASPE/AAHPERD publication

· Standards (State and NASPE)

· Success Stories Web site 

· Technology and PE or physical activity 

· Volunteers needed (invite parents)

· Web links for parents or students

· Webquests (learning activities from external websites)

· Wellness Fair or Health Fair 

· What’s going on in the gym (content)

· Why Children Need PE (link between academics and activity, socialization, lifetime activity, brain research, obesity trends…whatever your reason, there are tons)




Instructions for Creating a Website Using Microsoft SharePoint Designer

1. Organization – Before beginning, plan out the entire website beginning with the homepage (index.html).  For example, the following organizational chart identifies one homepage and three subpages.  Most webpages are organized in this “reverse tree” fashion and can have many levels.  


[image: image14]
a. IMPORTANT!!!!!!!! – All of the files (word, picture, text, etc) that support a webapge MUST be in the same folder as the internet file (html).  Therefore, if you want to use a picture in your website and the picture is on your home computer, it must be copied into the folder where the internet file (html) is located.  Otherwise, a red X will appear on the screen for pictures or the link won’t work for word, pdf (adobe), text, and other files.  More advanced websites typically use multiple folders but the idea is the same.   

b. Any time you would like to see what your webpage looks like, you may preview it.  Click “File” and then “Preview in Browser.”

2. Text

a. In the normal mode (design tab at bottom), SharePoint operates much like a word processor program.  You can create add text, change font colors, size, and qualities, align text, spell check, and other normal functions.     

3. Tables

a. Why use tables? – Organize content and permit a standard viewing experience for different web browsers (explorer, firefox, safari, etc).  Tables are the skeleton that hold everything in place (show example from wikiPE). 

b. Inserting tables – Click “Table” in the men bar and select “Insert Table.”  Specify the number of rows and columns.  You may also edit the alignment of the table on entire page, edit the width of the table in percent or pixels, add a background color or picture to the table, and change the borders.  

i. I recommend changing the cell padding and cell spacing to zero.  

ii. You may later edit the table by clicking “Table” in the menu bar and then “Table Properties”

c. Inserting or deleting rows and columns

iii. Click “Table” in the menu bar and select “insert” or “delete” and then the appropriate function

1. Shortcut: High the column or rows you want removed and click “backspace.” (not delete)

d. Adjusting the size of the table, columns, or  rows

iv. Hover the cursor over the edge of a cell or table until the double-arrow appears, click and drag to the desire size.  

e. Merging or splitting cells

v. Click “Table on the menu bar and under “modify,” select “merge” or “split” cells.  To merge cells, they must first be highlighted. 

f. Cell Properties  – This function allows you to edit individual cells .  Click “Table” then “Table Properties” and then “cell”.  The editable regions are similar to what you would find in the table properties box.  

4. Page Colors and Background – Click “Format” in the menu bar, then “Background.”

a. Background image – If you prefer an image in the background, first copy the file into the folder where the internet (html) file is located.  Next, click “Browse” and select the appropriate image file.  An image is naturally “tiled” or repeated throughout all viewable space.  

b. Background color – This changes the background color for the entire webpage.  Click the pull-down menu to the right of “Background” and select the desired color.

c. Links Colors – You may change the color of a non-visited hyperlink or a visited hyperlink to a color besides the automatic one displayed.  

5. Hyperlinks – Text or pictures that when clicked, direct the user to another webpage, a file, or an email address.

a. Hyperlink to an outside webpage – Highlight the text or picture you want to act as the link.  Click “Insert”in  the menu bar and then “hyperlink”.  Type or paste in the FULL internet address (http://www.PEcentral.edu for example) or the linked location.

b. Hyperlink to an existing file – Highlight the text or picture you want to act as the link.  Click “link” (chain icon) in the menu bar.  Click “choose file” and browse for the file located in the same folder as the internet file.  You can select almost any kind of file: word document (*.doc), adobe (*.pdf), movie (*.avi, *.mpeg, etc), text (*.txt), excel (*.xls), audio (*.mp3, *.wma), etc.     

vi. When viewing the webpage on the internet, certain files such as word and pdf files will open up inside the browser window.  Other files such as movie or music files will start the related program and be viewed in a separate window.  The program which opens a file is determined by the three letters following the period in the file name (*.ppt=powerpoint, *.mov=apple movie file).  

c. Hyperlink to an email address – Highlight the text or picture you want to act as the link to the person’s email address.  Click “Insert” in the menu bar, select “hyperlink” and then in the “Insert Hyperlink” window that appears, click “E-mail Address” in the bottom-left corner.  Type the email address into the space provided and click “OK.”  

6. Images

a. Inserting an Image – First, copy the image file to the folder where the internet (html) file is located.  To insert an image, click “Insert” in the menu bar and then select “Picture”.  Browse for the image and click OK.  You may insert alternate text for text only browsing or for individuals who are visually impaired and thus use a screen reader).  

b. Editing an image – The easiest way to change the size of an image is to click on one of the handles and drag it to the desired location.  If you would like to change the appearance of an image, right click on the image and select “Show Pictures Toolbar” where a host of options will appear.  

Website Creation with Microsoft Word 2007 or 2010

· Create a blank word document and immediately save it NOT AS A WORD DOCUMENT BUT AS A WEBPAGE.  Click “Save as type” in the “Save as” box.  Periodically save the document, don’t use save as.  

· Tables

· Why use tables? – Organize content and permit a standard viewing experience 

· Inserting tables – Go to the “Insert” tab and select table 

· Modifying page backgrounds

· To create a page background color, click the “Page Layout” tab, “page color” and then select a color.

· To create an image background, click the “Page Layout” tab, “page color” and then “Fill Effects.”  Click the picture tab then select a picture.  

· If you want the background to show through a table, again open the “Borders and Shading” window and select “No fill.”  

· Making tables invisible – Right click somewhere inside the table you want to modify and select “Borders and Shading” then none.  

· To apply a color to a portion of the table, follow the procedures directly above but select a color under the “shading” tab.    

· Hyperlinks – Text or pictures which when clicked, direct the user to another webpage, a file, or an email address.

· Hyperlink to an existing file or webpage – Highlight the text you would like to serve as the link.  Click the hyperlink icon on the “Insert” tab.  Click “Existing File or Webpage.”  Browse for the desired file or webpage and click “OK.”  

· Place in Document - Click the hyperlink icon on the web toolbar.  Click “Place in This Document” and select “Top of the Document.”  To link to other places, you must create a bookmark and link to it.

· Email Address – Highlight the text in the document that will serve as the link “Mrs. Jones Email”.  Click the hyperlink icon on the insert tab.  Click “Email Address,” type the address, and hit “OK.”

· Images

· Inserting an Image – On the “Insert” tab select picture then browse for it.  

· Adjust the size of the image by click on the handles 

· Editing an image

· Contrast – Use the picture toolbar

· Brightness – Use the picture toolbar

· Size – Either drag the handles or select the “Format Object” icon from the picture toolbar.  Once open, select the “Size” tab and insert the desired size.

· Cropping – Select the “Crop” icon from the picture toolbar.  Drag one of the picture’s handles to an appropriate cropping position.

Consider using free templates available online.  Save the file(s) to your computer and edit them to your liking:

1. http://www.oswd.org/designs/browse/ 

2. http://www.freewebsitetemplates.com/ 

3. http://www.steves-templates.com/templates.html 

4. http://www.mastertemplates.com/free-templates.htm 

5. or search google for “free web templates”

4 – Google Products 
All Google Products: http

HYPERLINK "http://www.google.com/intl/en/options/"://

HYPERLINK "http://www.google.com/intl/en/options/"www

HYPERLINK "http://www.google.com/intl/en/options/".

HYPERLINK "http://www.google.com/intl/en/options/"google

HYPERLINK "http://www.google.com/intl/en/options/".

HYPERLINK "http://www.google.com/intl/en/options/"com

HYPERLINK "http://www.google.com/intl/en/options/"/

HYPERLINK "http://www.google.com/intl/en/options/"intl

HYPERLINK "http://www.google.com/intl/en/options/"/

HYPERLINK "http://www.google.com/intl/en/options/"en

HYPERLINK "http://www.google.com/intl/en/options/"/

HYPERLINK "http://www.google.com/intl/en/options/"options

HYPERLINK "http://www.google.com/intl/en/options/"/.

Google Documents: http://www.google.com/google-d-s/documents/ 

1. Allow users to create word documents, presentations, spreadsheets, drawings and forms.  

2. Files may be edited by individual users or by several users in real-time.  

3. The default storage method is online, a term called cloud computing.  

4. Creating a document:

a. Click “create” in the upper left hand corner and select the type of file, assume for instructional purposes “document” was selected.  

b. At this point, a blank word processing document opens 

c. Important differences: 
i. Documents are automatically saved, there is no save or save as feature. 
ii.  Users may at any point save the document to a local computer by clicking “File”, “Download as” and then a document type. 
iii. Users can also upload files from their local computer to the cloud. To do so, click “upload” when you first log in and the upload icon next to “create.” To edit any file uploaded, it must be converted to Google Doc format. For example, a file originally composed via Microsoft PowerPoint will be converted to Google Presentation format online.   
5. Sharing – this is one of the great features of cloud documents.  To share with others, click “File” and then “share” and specify who can access and edit the document.  Select “public,” “anyone with the link” and “private.”  

6. Users can store 1024 megabytes of information online.  To view the files you have stored online, click “documents” at the top of the page.  
Google Sites: www.sites.google.com 
1. Log into your Google Account and clicks “sites” near the top of the browser window.

2. Click “create new site” on the subsequent page.  On the following page, name the site and choose between using a template or theme; themes are generally easier to edit and therefore recommended.  Input data into the required fields and click “create site.”  
3. To customize the site, click pencil icon in the upper right hand corner for edit page

4. Click “layout” and select one of the options. Users may edit text much like a standard word processing document. 

5. To create subpages under the homepage, save the homepage.  Upon saving, new options will appear in the upper right hand corner including the option to create a subpage.  Click the new page icon in the upper right hand corner.  Name the subpage and then importantly select “Put page under Home.”  Users will automatically be taken to the subpage, which can be edited in the same way as the homepage.  
a. Attachments, such as Word or Pdf files, may be added by clicking the “attachments” options towards the bottom of the subpage.  Attachments may not be added on the homepage.  

6. Several additional features are available via the pull down menu in the upper left hand corner.  Two more commonly used tasks are inserting pictures or links. To insert a picture, click “insert,” select “image” and follow the prompts. To insert a link, click “insert,” select “link” and then choose either an existing page (subpage) or a web address that already exists such as http://aahperd.org.   
7. To manage website options such name, description, web address and other features, click “more” in the upper right hand corner and select “Manage site.” Users may create multiple websites and collectively store up to 100 megabytes of data.  
Option 5 – Facebook 
[image: image15.png]



Option 6 – Editing Music 
Overall Uses:

1. Cut out “dead spots” in songs where there is no music.  Many elementary school PE teachers use music to stop and start students during activity while increasing motivation and student enjoyment.  By eliminating the “dead spots,” students will better know when to stop and start.  This improves both behavior management and safety.  Edited songs will be saved together to form one long uninterrupted track of music, usually as long as an entire class. 

a. You can also use this technique to cut out swearing or inappropriate sections of a song.

2. Add your own voice and cues to music by overlaying tracks (not as hard as it sounds!)

3. Record directions for an activity, fitness assessment, etc into your computer and then burn them onto a music CD.

Instructions for Editing Out Dead Spots

1. Start Microsoft Movie Maker (automatically included in Windows XP and Vista computers) – Click the start icon and browse for Movie Maker under “All Programs.”  Usually, it is listed inside the “Accessories” folder but it may be elsewhere.  

2. In the “Movie Tasks” pane on the left, under “1. Capture Video,” click “Import audio or music.”

3. Browse and select the audio files you would like to import and click “Import.”

a. You can select mp3, wma, and wav files among others.  The program will not import apple files, typically  m4a files.  

b. Do not import over 74 or 80 minutes of music because that is the most which can be burned onto a CD.

4.  The files you imported will now appear in the collections pane (middle of screen).  Select all of the files and drag them down to the storyboard at the bottom.

a. The storyboard view will automatically convert to the timeline view and a graphical representation of the song will appear in the “Audio/Music” line.  

5. Save your work at this point

a. Click “File” and then select “Save Project.”  

6. Adjust the zoom ([image: image16.png]


 by clicking on the positive or negative magnifying glasses.  You should be able to view the current song you are working on within the confines of one computer screen.  

7. Starting from the beginning of the song, look for dead spots where there is little or no music.  You can discern these spots by the amplitude of the sound waves; little or no height sections can be deleted using the following steps:  

8. Editing Music[image: image17.png]0500




a. [image: image28.png]


Deleting dead spots at the beginning or end of a song - click on the file with the hand tool ((), then hover over the end of the file until a double red arrow appears (
[image: image18.png]


), click and hold the click, then drag the double red arrows over the part of the song you want deleted.  Stop at the portion of the song you DO NOT want deleted, release the click.  That section of song you moved the double red arrow over is now deleted.  

b. Dead spots in the middle of a song – Click the cursor (tall blue line with “head” at top, image at right) and drag it to the beginning of the dead spot in the middle of the song.   Next, cut the song by clicking the cut tool ([image: image19.jpg]


).  The cut button is located the far right of the play button.  Now the song is cut in two pieces.  Remove the dead spot in the manner described in 7a via the double red arrows.  An open spot will appear between the two music segments; don’t worry about it until later.

i. If you prefer, you may cut the song twice until the dead spot becomes its own section.  Right click the section and select delete.  

c. Repeat steps 7a and 7b for all of the imported files or you achieve the desired duration of music.  

9. Eliminate Gaps – Where music was deleted, there is a “hole” in the song.  For purposes of an example, assume there is a gap between the first and second music section.  Click on the section, hold the click until the hand tool appears, and drag the second to the left until it meets the first section.  A thick blue line will appear as you drag it ([image: image20.jpg]Untitled - Windows Movie Maker.
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).  

a. Repeat this procedure proceeding from the beginning until the end of all tracks.   

10. Overlapping audio tracks – Where one section or track of music meets another, there may be a brief gap in the music.  To eliminate this gap, overlap the tracks.  Again with the example, assume that track 1 and track 2 are now directly against one another.  Click track 2, hold the click until the hand tool appears, and drag it slightly over track one.  The end of the thick blue line will reshape as a diagonal.  The length of the diagonal is the length of the song overlap.  You may also overlap track one onto track two.  

a. Repeat this procedure for each location where two tracks meet one another.

b. This step enhances the quality of the music.  As a teacher, you may choose not to complete this step.  However, for this assignment, it is a requirement.  

11. Review – start at the beginning and review all of the imported files to verify the accuracy of all edited tracks.

12. Save your project

a. Click “File” and then select “Save Project.”  

13. This STEP IS ESSENTIAL

a. Up to this point you have been editing and saving a PROJECT, you have NOT YET saved a music file.  To save your project as a music file, click “File” in the menu bar then select “Save Movie File” for Windows XP computers and “Publish Movie” in Windows Vista computers.  Providing that you have not added any video to the project, the file will save as an audio file (wma format).  Next, select “my computer,” give the file a name, and browse for the desired location.  You may adjust the size of the file but I suggest the “Best Quality for Playback.”  

14. Burning a Music CD – Burning music CD’s can be accomplished by a variety of programs such as Roxio, Nero, and various freeware programs.  DO NOT BURN A DATA CD; burn a music CD which will play in a stereo or music box.  I do not recommend Windows Media Player, it can burn music CD’s but it is confusing.  

a. If you do not have a CD burner on your computer besides Windows Media Player, I suggest downloading and installing burn4free from www.download.com.  There are many other free CD burners to choose from on the website.  

b. Afterwards, TEST your music CD in a regular stereo, not a computer to ascertain whether it works.  

7 – Smartphones to Promote Physical Activity

Check out Dr. Cummiskey’s article in the October 2011 issue of JOPERD

8 – Posting YouTube Videos

1. Go to YouTube (http://youtube.com)

2. Click “upload” in the upper right hand corner and follow the prompts

9 – Webquest

History of American Physical Education: A Webquest
Kin 103, Dr. Cummiskey
What is a Webquest?

· A webquest is an inquiry-oriented activity in which most or all of the information used by learners is drawn from the Web. Webquests are designed to use learners' time to focus on using information rather than looking for it, and to support learners' thinking at the levels of analysis, evaluation, and synthesis.  A typical webquest includes an 1) introduction, 2) a description of the task, 3) specific questions or tasks students must complete online, 4) a list of resources, 5) and the evaluation method.  You may or may not link the questions to resources; that’s up to you.  
Assignment:
1. Page 1: Typed answers to my history webquest.  Do not restate the question.

2. Pages 2-7: Your own webquest focused on a topic of your choosing (i.e. Games of the Future).  You must create your own name for the bookmarks and not recycle ones from this document.    

a. Design your own webquest and email the document as an attachment.  Use the proper file naming structure identified in the syllabus.  Your webquest must have the five sections identified above that students can access from a hyperlinked table of contents on its own page.  Each section must begin on a separate page (like this example).  Include at least two images to make the webquest more engaging.  Your webquest must have a minimum of seven questions and four resources, two of which must be higher order questions that are underlined.   

Creating Bookmarks – 1) click where you want the bookmark to go, 2) click the Insert tab on the Ribbon, 3) in the Links group, click Bookmark, and 4) type a name in the Bookmark Name box (no spaces)

Hyperlinking to Bookmarks – 1) highlight the text you want to link, 2) click the Insert tab on the Ribbon, 3) in the Links group, click Hyperlink, 4) click Bookmark on the right, and 5) select the correct one

History of Physical Education Sample Webquest

Sample for KIN 103

Dr. Cummiskey

Table of Contents
· Introduction
· Task Description
· Questions
· Resources
· Evaluation
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Introduction

During this webquest you will trace the important people, subjects and dates that have had a major impact on physical education in the United States.  It is hoped that with this information you will gain an appreciation for and insight in to the field of Physical Education.
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A Gymnastic Charge (Dioclesian Lewis, Circa 1865)
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Back to Top

Task Description

The questions below will lead you on a chronological quest into the history of physical education.  Each question is linked to a resource.  In some cases, the resource will not provide all of the information necessary to answer the question.  In other cases, you will need to search the web for additional information.   To complete the assignment, answer the questions on a separate sheet of paper.  Be sure to number the question you are answering.  If you have questions or difficulties, be sure to email me.  Best of luck and happy hunting.  
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Early Women’s Volleyball
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Questions

1. What was the first college in the U.S. to develop a men’s physical education program? In what year? R1  (resource 1)
2. Who invented volleyball? In what year? What was it originally called?  R1

3. What is Kinesiology?  R2
4. During the National Period in Europe (1700 – 1850) two individuals in Germany came up with a system of physical training that later would have a profound influence on American physical education.  Who were they and what did they develop? R3
5. Who was Per Henrik Ling? What systems did he espouse? R3 - Sweden

6. What was physical education like during the colonial period of the U.S.?  R3
7. Physical education was introduced in the U.S. by whom and in what year? R4
8. Who were two famous physical education leaders who led physical education from being totally for males and more for participation of females as well? R4
9. What’s a Turnverein? R5
10. Finish the following quote by Catherine Beecher “When physical education takes the proper place in our schools, young girls will be trained in class-rooms to …” R6
11. The Sargent Test is otherwise known as … R7
12. When were the first health lectures given at West Chester University and who was the lecturer? R8
13. What year marked the formal beginning of the Department of Physical Education at West Chester University? R8

14. What critique of the history of WCU PE can you offer in light of the overall history of physical education? R8
15. After examining some of the benefits of physical education today, create an additional benefit not included in the article.  R9 
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Resources
The following are the sites you will use to complete the webquest:
1. History and Physical education - http://www.eou.edu/~bsather/pes270_history_philosophy_sport/timeline.pdf  

2. University of Fraser Valley - http://www.ucfv.ca/kpe/FAQ.htm  

3. The History of Fitness - http://www.unm.edu/~lkravitz/Article%20folder/history.html  

4. Physical Education in the U.S. - http://www.uncp.edu/home/canada/work/allam/17841865/history/educate.htm#Physical%20Education 

5. Turnverein - http://www.iupui.edu/~hoyt/Hofmann.htm   

6. Beecher - http://newman.baruch.cuny.edu/digital/2001/beecher/catherine.htm  

7. Sargent - http://www.topendsports.com/testing/history-sargent.htm  

8. Our History - http://www.wcupa.edu/_academics/healthsciences/kinesiology/history.asp  

9. Benefits of PE - http://education.csm.edu/students/atejral/benefits_of_education.htm 
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Instructions 

A webquest is an online learning assignment where students use one or several internet websites for one of three principal purposes:

1. Collect information and answer questions – Students are directed to several websites from which they must answer teacher supplied questions.  For example, students learning the rules and strategies of badminton through teacher prescribed questions and websites instead of taking time in class to teach those topics.

2. Complete interactive experiences – Students learn and apply information.  For example, they could learning about BMI and calculate their own on the CDC’s (Center for Disease Control and Prevention) website.  
3. Constructive – Students create an outcome in response to the webquest.  For example, students may be required to create a personal fitness program from different fictional characters and health related fitness profiles.

For more information on teaching cognitive concepts via the internet, go to: http://thenewpe.com/conferences/presentations.htm and click the file titled “Teaching physical education concepts via the internet (extension ideas).”
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